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Complete Lineup of CP1E and NB Series
 
 
 
 
 
 

 
 

 
■CP1E Series 

・Application models including built-in 3 ports types 
RS-232C port, USB port, and RS-485 port are incorporated. 
As well as HMI, Inverters and Temperature Controllers can be connected without using Options.
 

・Improved built-in 2 ports types 
 
・Basic models including CPU Unit with 60 I/O points 

 

Full range of products, ranging from basic models to application models that enable addition of 
communications ports, allows you to select the right model to suit your application. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

■NB Series 
・More than 65,000 display colors TFT, color touch-screen and  
 Ethernet communication for all models  
・Serial port and USB 
・USB memory stick support 
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3.5 inch 5 inch 7 inch 10.1 inch 

 
 

 

   10      14     20      30        40       60   

 
 
 
 
 
 
 
 
 
 
 
 

8K 
steps 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2K 
steps 

E□□(S)-type CP1E CPU Units Application Models (Built-in USB port) 

N□□S-type CP1E CPU Units Application Models (Built-in 2 ports : RS-232C, USB) 

N□□S1-type CP1E CPU Units Application Models (Built-in 3 ports : RS-232C, RS-485, USB) 

N□□-type CP1E CPU Units Application Models (Built-in 2 ports : RS-232C, USB, Option Board) 
Program 
capacity 

Number of I/O points

USB

RS-232C

NB-Series 

CP1E-Series

RS-485 
(Modbus) 



New to NB-Designer 

Select devices from the Graph Element Window. 

I started the NB-Designer. What should I do next? 

I'm worried about the new software...  

(1) Drag and drop NB to be used. 

 

 

(2) Drag and drop Connector (communication cable type) to connect to a communications port of the NB. 

 
(3) Drag and drop PLC to be used to connect the connector to a communications port of the PLC.  

 

(1) 

(2) 

(3)
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I selected devices. 
Do I have to set up the NB? 
How to set up? 

(1) Double-click the NB to open the [HMI Attribute] 

dialog box.  

 

 

 

 

 

 

 

 

 

(2) Make the same communication settings as for the PLC in the [COM1 Setting] tab.  

 

 

 

 

 

 

 

(3) Uncheck the [Display Task Bar] in the [Task Bar] tab. 

 

Set in the HMI Attribute dialog box. 

Double-click 

When the COM2 is used, 

set in the [COM2 Setting] 

tab.  

As the default is checking the [Display Task Bar], 
uncheck it when the Task Bar is not used. 
Refer to 3-10-2 Task Bar in the Programmable 
Terminals NB-Designer Operation Manual (Cat. No. 
V106-E1) for details on the Task Bar. 

In the above example, the PLC is connected with the 

COM1 of the NB7W.  

 



Open the HMI Edit Window. 

Settings are completed. 
How to start screen creation? 

(1) Select the [HMI Edit Window] in the [Window] menu. 

 

 

 

 

 

 

 

(2) The HMI Edit Window appears. 

 

 

 

 

 

 

 

 

(3) Drag and drop a component from the [PLC Parts] or [Function Parts] in the Graph Element Window, 

which is located to the left of the HMI Edit Window, to the HMI Edit 

Window. A component is placed on the Window. 

When the HMI Edit Window 

appears, [Frame 0] will 

appear automatically.  

Area inside     is 
called “HMI Edit 
Window”. 

 

Frame 0 



Create Beautiful Screen with NB-Designer

Even if the component is enlarged, the 
position of the tag does not change. 
How to move the tag to the center of the 
component? 

Use the Align Tag to Vertical/Horizontal-Center of 
Component icons. 

(1) A component was created. 
 
 
 
 
 
 
 
 
(2) Although the component was enlarged, the tag characters “RUN” were not located at the center of the 

component. 
 
 
 
 
 
 
 
 
(3) Click the [Horizontal Middle Label] and [Vertical Middle Label] icons to move the tag to the center of 

the component.  

How to move the tag to the center?

1)  Click the [Horizontal Middle Label] icon. 2)  Then, click the [Vertical Middle Label] icon. 

 

The tag moved to the horizontal center position. The tag moved to the vertical center position. 
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How to make the multiple components with 
the same size at once? 

Created components are not equal in size... 

The following process shows how to make all components with the same size at once. 

 

 

 

 

 

 

 

(1) Select one component as the reference.     
 (In this example, the “RUN” switch is 

specified as the reference.) 
 

 

 

 

 

 

 

 

 

(3) Click the “Equal Same” icon or select 
[Both] under [Size] in the [Edit] menu. 

(2) To select all switches, press and hold the Shift 
key while selecting the “STOP” and “START” 
switches. (Selected components are surrounded 
by a pink frame.) 

(4) Now all selected components are 
the same size.  

Components become the same size 
as the component selected in Step (1). 

Use the    Make Same Size icon. 

 



 

(1) Select one component as the reference, and then press and hold the Shift key while selecting all 
other components to align. (In this example, the “RUN” switch is the reference.) 

 

 

 

 

 

 

 

 

 

(2) Click the [Align Left] icon or select [Left] under [Align] in the [Edit] menu. 

 

 

 

 

 

 

 

 

(3) Select [Vertical Even Spacing] in the 
[Edit] menu to make the vertical space 
between the components same while 
selecting components.                        

                          

Use the Align function. 

I could make the components with the 
same size.  
How to align the components? 

All components are aligned along the left side of the “RUN” switch.

 

(4) Then, click the [Horizontal Middle Label /
Vertical Middle Label] icons to move the tags 
to the center of the selected components at 
once.



CX-Programmer "Smart Input" 
The instruction input assistance function enables 
programming by selecting instructions from the list.  
 
When you begin typing an instruction from the keyboard while in the Ladder Editor Window, suggested 
instructions are displayed. All you have to do is select the instruction from the list for easy input even if you do 
not remember the entire mnemonic. 
 
(1) When you type “+”, suggested instructions are displayed. 

   
 
(2) Press the “↓” key to select the instruction to be input in the list.  

Instruction names are displayed, so you can check instructions on the screen.  

 

Easy Programming with Smart Input Function 

Instruction names are displayed, so you 
can check instructions on the screen.  

Press the     to select the 
instruction to be input. 

 ↓ 

 

I forgot the mnemonic for the DOUBLE INCREMENT 
BINARY instruction! 
I remember it starts with “+”.  

When you press the    , a list of 
instructions starting with “+” is displayed. 

 + 
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I forgot the bit address of the “Equals Flag”! 

CX-Programmer "Smart Input" 
The auxiliary bit input from lists function enables 
special bits in the Auxiliary to be selected from lists, 
eliminating the need to remember addresses. 
 
Clock Pulse Flags, Condition Flags, and other special bits in the Auxiliary can be selected from lists. 
 
(1) When an instruction is input, the [Auxiliary Relay Area] is displayed.  

 

 
 
(2) If you select the [Auxiliary Relay Area], a list of Auxiliary Bits is displayed. 

Press the “↓” key to select the Auxiliary Bit to be used. 
 

 

Select the [Auxiliary Relay Area].  

Press the     to select the 
Auxiliary Bit to be used. 

 

 ↓ 



 

How to easily copy instructions to create the 
same instructions?  

CX-Programmer "Smart Input" 
The address incremental copy function can be used 
to reuse the instructions. 
To create the same group of ladder instructions more than once, the address incremental copy function can 
be used to easily create copies of the instructions with different addresses by inputting an address offset. 
(1) Right-click to display the [Address Incremental Copy]. 

   
 
(2) Input offsets and a copy count. 

 
 
(3) Click the [Paste] button on the [Address Incremental Copy] Dialog Box to copy the ladder instructions.  

 
 

Address offsets can also be set 
individually in CH or Bit unit.  

 

 Input offsets.  
Specified offsets are 
applied to all addresses. 

 

 
The instructions with the offset 
addresses are pasted.  

Select the [Address Incremental Copy]. 



 

The monthly news, C&N 
- OMRON Cost-effective Control Devices - 

 
Vol.5 

How can I easily input text and attributes of 
switch and lamp labels for both ON and OFF 
states? 

Quick Screen Creation with NB-Designer 

Use the Copy Text to All State Button 
in the Label Tab Page to copy. 

 
Select the [Label] Tab of the [Bit Button Property] Dialog Box. 
Check the [Transport Font], and input text in the [Message] Field. (Example: START) 
Click the [Copy Text to All State] Button. 
 

 
 
 
 
 Text is copied to the State 1 in the Label List. 

           
 
 

Click the [State] Button of the [Copy Font Attribute to] in the [Font 
Attribute] Field in the [Label] Tab Page to copy the font size, color, position, 
and other attributes of the State 0 to the State 1. 

Complete! Easy! 
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Create Beautiful Screen with NB-Designer 

I accidentally move some of aligned components.  
Can I lock components?  

Use Lock Position to lock components. 

(1) Lock a component to prevent the user from accidentally moving the component. 

   

 

 

(2) A lock-shape mark appears on the component. You can unlock it in the same way. 

The component with a lock-shape mark can be edited in the property. 

  

(1) Select the component to lock. 

(2) Right-click. 

(3) Select the [Lock Position]. 

You cannot move the component with the 
mouse. Lock Position can prevent accidental 
movement of aligned components. 
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Specify Offsets for Addresses 
 

What can I do by specifying offsets for addresses? 

You can program by specifying offsets 
for start addresses. 

It is possible to dynamically specify the offset by specifying a word address in I/O memory for the offset. The 
contents of the specified word address will be used as the offset. This makes programming more flexible. 
 

♦Overview 
<< Bit Addresses >> 
The bit address is offset by the amount specified by n (number of offset bits) from A (start bit address). 
* n (offset) can be specified as a decimal constant or word address (but CIO Area addresses cannot be 

specified). 

   
  Examples 

10.00[2]  ⇒ 10.02 
10.00[W0] ⇒ 10.05 (When W0 = &5) 

 
<< Word Addresses >> 
The word address is offset by the amount specified by n (number of offset words) from A (start word address). 
* n (offset) can be specified as a decimal constant or word address (but CIO Area addresses cannot be 

specified). 
 

   
Examples 

D100[2]  ⇒  D102 
D100[D0] ⇒  D216 (When D0 = &116) 

 
Note. The CP1H and CP1L do not support this function. If you use the CP1H or CP1L, use Index Registers. 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
♦Application Example for Address Offsets 
 
The addition data (D10[W10]), which varies depending on the value of the input data (D0) when the input 
trigger (1.01) turns ON, is added, and the sum is output to the calculation result (D200).  
The number of data for measurement varies depending on the value of the input data. 
 
Value of input data 
(D0) 

Number of offsets  
(W10) 

Addition data 
(D10[W10]) 

Number of data 
(D100[W10]) 

D0 < 200 &0 D10 (= D10[0]) D100 (=D100[0]) 
200 ≤ D0 < 500 &1 D11 (=D10[1]) D101 (=D100[1]) 
500 ≤ D0 &2 D12 (=D10[2]) D102 (=D100[2]) 
 

 

 

 

 

 
 

Depending on the value 
of the input data, the 
number of offsets is 
transferred to W10.  

Depending on the value 
of the input data, the 
number of data D100, 
D101, or D102 is 
incremented.  

Depending on the value 
of the input data, the 
addition data D10, D11, 
or D12 is added, and the 
sum is output to the 
calculation result.  
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(1) Start NB-Designer, and select [Configuration and Setup Window] in the [Window] Menu. 

(2) Double-click the NB (example: NB7W). 

(3) Check the [Save to External Memory] in the [Event History Setting] Tab Page. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

♦ Additional Information 
When the [Save to Recipe Data Field] surrounded by a blue border is checked,  

history data can be saved to non-volatile memory (RW) in the NB. 

Save Alarm Histories to USB Memory Stick 

How can I save alarm histories of the NB 
to a USB memory stick? 

Just check the Save to External Memory 
in the Event History Setting Tab Page! 
 

 

Double-click 

Complete! 
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(1) Place a component (Bit Switch in this example) in the Edit Window. The Property Dialog Box of the 

component appears. Click the [Text Library] Button to display the [Text Library] Dialog Box. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
(2) Click the [Add] Button in the [Text Library] Dialog Box. 
 
 
 
 
 
 
 
 
(3) The [Add Text] Dialog Box appears. Enter the [Title] and [State No.].  

Give each label an easy-to-understand Title because the Title is used when a language is selected 

in the Text Library. Click the [OK] Button.      

 

 

 

 

Display Labels in Multiple Languages 

How can I display multiple languages on the NB? 

Text Library enables up to 8 kinds 
of languages to be displayed. 

 

Title: 
Enter a Title of the multi-language label 
(“UNTEN” in this example). 

State No.:  
Enter “2” (ON and OFF). 
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(4) The Title "UNTEN" was added to the Text Library.  
 
 
 
 
 
(5) State 0 and 1 are displayed under the Title by clicking the Title “UNTEN”.  
 
 
 
 
 
 
 
(6) Enter “運転” in the [Language1] (Japanese) Column for State 0 and 1. 

 

 

 

 

(7) Enter “RUN” in the [Language2] (English) Column for State 0 and 1, and click the [OK] Button. 

 

 

 

 

 

 

 

 

(8) The Property Dialog Box appears. Check the [Use Text Library]. 

”運転” set in step (6) are displayed in the Label List. 

 

 

 

 

 

 

(9) When “Language2” is selected, “RUN” set in step (7) are displayed. 

 

 

     

 

 

 

 

♦ Additional Information 
The language displayed on the label can 

be changed by setting the following 

values to system memory LW9130. 

0: Language1 

1: Language2 

2: Language3 

The multi-language label can also be 

selected by selecting the Title from the list 

that appears when ▼ of the Title is clicked. 
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Use the N-type CP1E CPU Unit with transistor outputs when using pulse outputs. 

CP1E-N□□DT-□  (Sinking) 

CP1E-N□□DT1-□  (Sourcing) 

■ Feeding 
Create the program to perform trapezoidal control when the input (CIO 0.00) goes ON. 

 

   

 

 

 

 

 

 

 

 

 

 

Easy Positioning Using Pulse Outputs 

How can I perform positioning using pulse outputs 
from the CP1E?  

Use the PLS2 instruction for easy positioning! 

Built-in pulse output 0 

CP1E 

Servomotor/Servo Drive 
G5 Series 
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Setting and Programming 
(1) PLC Setup 

There are no settings that need to be made in the PLC Setup. 

(2) DM Area Settings 

Make settings for the PLS2 instruction. 

Set the parameters in D0 to D5 and the starting frequency in D6 to D7.  

Setting Address Data 

4-digit hexadecimal 

Acceleration ratio: 300 Hz/4 ms D0 #012C 

Deceleration rate: 200 Hz/4 ms D1 #00C8 

Target frequency: 50,000 Hz D2 #C350 

D3 #0000 

Number of output pulses: 600,000 pulses D4 #27C0 

D5 #0009 

Starting frequency: 100 Hz D6 #0064 

D7 #0000 

(3) Ladder Program 

 
Port specifier and control data settings for the PLS2 instruction are as follows.  

 

・Port specifier 

  0000 hex: Pulse output 0, 0001 hex: Pulse output1 

 

・Control data 

 

 

Specifies Pulse output 0 

Specifies Pulse + direction 
output method, CW direction, 
and Relative pulses 

    

15      12 11      8 7        4 3        0 

    

Always 0 hex 

Pulse output method 
 1 hex: Pulse + direction 

Relative/absolute 
specifier 
 0 hex: Relative pulses 
 1 hex: Absolute pulses 

Direction 
0 hex: CW 
1 hex: CCW 

   



 

<Application Example> 
■ Interrupt Feeding 
Speed control is used to feed wrapping material. When the marker sensor detects a mark, 

fixed-distance positioning is performed before stopping.  

High-precision positioning can be achieved by immediately stopping pulse output when an interrupt 

input is received.  

Refer to the CP1E CPU Unit Software User’s Manual (Cat. No. W480) for details. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Built-in pulse output 

Servomotor/Servo Drive 
G5 Series 

CP1E 

Vertical Pillow Wrapper 

Marker 
sensor 

Interrupt input  
(0.04) 

NB series 



 

(1) Connect the NB with a computer using a USB or other cable. 
(2) Start the NBManager, and select the [Upload Operation] Tab on the left of the screen. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(3) The [Upload Setting] Dialog Box appears. Check the [Project Data (required)] and click the [OK] 
Button. After the [Save As] Dialog Box pops up, specify the file name and path to upload and then 
click the [Save] Button.  

 

 

 

 

 

 

 

(4) The [Password (Upload)] Dialog Box appears. Enter the password set for the uploaded screen, and 
click the [OK] Button.  
The default password is "888888".  

 

 

 

Upload Screen Data from NB 
 

How can I upload the screen data from the NB? 

NBManager enables the screen data upload. 
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(5) The screen data upload starts. When the upload is completed, the “Upload succeeded!” Dialog Box 
will pop up. Click the [OK] Button. 

 
 

 

 

 

 
 

 

(6) The uploaded file (file name: Omron_NB.pkg) can be found in the folder specified in step (3). 
The PLG file is a file that is generated when the NB project data is compiled.  

(7) Convert the PKG file to the format which can be handled with the NB-Designer (decompile).  

(8) Select the [Decompile Operation] Tab. Click the [Select] Button in the [Select PKG File to 
Decompile:] Field to specify the PKG file uploaded in step (6). 

 
 

 

 

 

 

 

(9) The PKG file specified in step (8) is displayed at      in the diagram below. Click the [Select] 
Button in the [Select Target Project Folder to Decompile] Field to specify the folder to decompile, 
and then click the [Decompile] Button. 

 

 

 

 

 

 

 

 

 

(10) The [Decompiler] Dialog Box appears. Enter the password entered in step (4), and then click the 
[OK] Button. Exit the NBManager after the “Decompilation success” Dialog Box pops up.  

 

 

 

 

 

 

(11) The decompiled screen data for the NB-Designer is uploaded to the folder specified in step (9). 

 

♦Point♦ 
NBManager is used to upload the screen data from the NB. 
To upload the NB screen data, a PKG file is uploaded and then "decompiled" using the 
NBManager. 



 

Start the NB-Designer, and select [Configuration and Setup Window] in the [Window] Menu.  
Although the NB, PLC, and cable seem to be connected, they are sometimes not connected properly.  

 
 

♦ How to check 
(1)  Left click and drag the PLC or NB around. If one component is separated from another, the 

connection is not made.  

 
 
(2) If the connector follows when the PLC or NB is moved, the connection is made properly.  

 
 

Problem with Connection  

Although connection settings between NB and CP1E 
seem to be correct, I get a connection error.  
Where should I check? 

You can check the connection in the 
"Configuration and Setup Window". 

 

Move the PLC or NB. 

They seem to be connected. 

The connection is OK! 
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A CP1E instruction is used to scale.  
 

1.  When a 0 to 10-V voltage input to an Analog Input Unit is input to memory as 0 to 
6000, convert the value into a value between 0 and 10000.  

  
2. Convert a set value between 200 and 500 to output a voltage between 2 and 5 V.  
 
 

 

 

 

 

 

 

 

 

 

             

 

Scaling Analog I/O Values 

How can I convert analog input voltages into 
arbitrary values and display the values? 
How can I convert arbitrary set values into analog 
voltages and output voltages?  

Use the APR instruction for scaling 

 

Output 

2 to 5 V 

(CIO 102) 

Input  

0 to 10 V  

(CIO 3) 

CP1E 

CP1W 
Analog I/O Unit 
(Resolution: 6000) 

NB Series 

Set value 

200 to 500 

Displayed value 

0 to 10000 

Scaling 
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1. When a 0 to 10-V voltage is input to the analog input word (CIO 3) as 0 to 6000, convert the value 
into a value between 0 and 10000 and output the result to D200.  

 
 
 
 
 
 
 
 
 
 
 
 
Setting and Programming 
(1) PLC Setup 

There are no settings that need to be made in the PLC Setup.  

(2) DM Area Settings 

Setting Address Data 

Control word * D100 #0800 

Unscaled minimum value (0) D101 &0 

Scaled minimum value (0) D102 &0 

Unscaled maximum value (6000) D103 &6000 

Scaled maximum value (10000) D104 &10000 

  

(3) Ladder Program 

Use the APR instruction. 

 

 

*: Refer to page 4 for the detail of the APR instruction. 

Analog input word  
(original data CIO 3) 

Word where data will be 
output after scaling 

First word for scaling 
settings 

6000 
(10 V) 

0 
(0 V) 

10000 

Data input to Analog I/O Unit  
(Unscaled: 0 to 6000) 

S
ca

le
d 

va
lu

e 
 

(0
 to

 1
00

00
) 

 (Data in CIO 3)  

(D200)  

0 



2. Convert a value between 200 and 500 in D300 into 2 to 5 V to output the voltage from the analog 
output word (CIO 102). 
 
 

Convert into 2 to 5V (converted data: 1500 to 6000) within the 1 to 5-V output range (converted data: 0 to 6000) of 
the Analog Output Unit.  

  

 

 

 

 

 

 

 

 

 

 

Setting and Programming 
(1) PLC Setup 

There are no settings that need to be made in the PLC Setup. 

(2) DM Area Settings 

Setting Address Data 

Control word * D110 #0800 

Unscaled minimum value (200) D111 &200 

Scaled minimum value (1500) D112 &1500 

Unscaled maximum value (500) D113 &500 

Scaled maximum value (6000) D114 &6000 

 

(3) Ladder Program 

Use the APR instruction. 

 

*: Refer to page 4 for the detail of the APR instruction. 

 

Unscaled value  
(original data D300) 

Analog output word 
(CIO 102) 

First word for scaling 
settings 

6000 
(5 V) 

1500 
(2 V) 

500 

200 

Value output to Analog I/O Unit  
(Scaled: 1500 to 6000) 

U
ns

ca
le

d 
da

ta
  

(2
00

 to
 5

00
) 

 (Data in CIO 102)  

(D300)  



Reference: Detail of APR instruction 

 

 

 

 

 

 

 

C: Control word 

Set for "Signed Integer Data (Binary)".  

Control Word Setting 

#0800: Binary numeral (0000 1000 0000 0000) 

   
 

Setting Address Data 

Control word C #0800 

Unscaled minimum value  (X0) C+1 X0 

Scaled minimum value (Y0) C+2 Y0 

Unscaled maximum value (Xm = X1) C+3 X1 

Scaled maximum value (Ym = Y1) C+4 Y1 

 

S: Source data  

   Specify the word address of the input data before scaling. 

R: Result word 

   Specify the word address where the data will be output after scaling. 

 

The number of coordinates is 1 (m=1), so 
set bit 0 to 7 to "0" (=m-1). 

X1 X0 

Y1 

Unscaled data 
S

ca
le

d 
da

ta
 

S 
Input data 

D 
Scaled 
result 

Y0 



The Event component can display history and time. 
The history can be saved to the recipe memory and USB memory.  
The Event component allows you to specify the triggering conditions using values of 
word addresses and comparison with specified values. 

Convenient Use of NB Event  

What is the difference between Event and Alarm? 
How can I use them properly? 

Difference between Event and Alarm components 
 

 

The Alarm component cannot display history and time. 

The occurred alarm information is displayed in the specified area. 
When the bit address which worked as an alarm trigger is released, the alarm display will be 
removed. 

< Example > 
When there is some information that is required to be stored and some information that is not 
required to be stored. 
 
 

 
There is a limit to the number of logs that can be stored in the NB, so storing unnecessary logs 
reduces the number of logs that is required to be stored. 

 
Register the information that is required to be kept in history to Event and other 
information to Alarm, which enables storing as many logs as possible. 

 

Proper use of Event and Alarm components 
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The specified screen will pop up  

Confirm Dialog: when an ongoing event is touched. 

Trigger Dialog: when an event occurs. 

 

How can I use Event Setting more efficiently? 

♦ Classifying events  
* 256 groups can be selected. 

(1) Select [Event Setting] in the [Project Database]. Set [Type: 0 to 255] to an arbitrary group.     

                            

 
(2) Drag the [Event] component icon from the [Parts] to open the [Event Property] Dialog Box. Set the 

Display Range in the [Event Setting] Tab Page. 
                         

 

 

Useful functions of Event 
 Select [Event Setting] in the [Project Database]. 

Click this icon! 

♦ Associating with screen displayed when event occurs 
Select the [Add] or [Modify] Button in the [Event Setting] Dialog Box, and set the display method.   

 

♦ Editing event settings in CSV file 
Select the [Export] Button in the [Event Setting] Dialog Box. Edit the CSV file, and select the 
[Import] Button. 

 

Events set for 0 to 255 are displayed.  

Only the event set for 2 is displayed.  

Group 0 



 
 

.

 
CP1E CPU Units normally repeat processes in the following order: overseeing processes, program 
execution, I/O refreshing, peripheral servicing. During the program execution stage, cyclic tasks (ladder 
programs) are executed. 
 
The interrupt function, on the other hand, allows a specified condition to interrupt a cycle and execute a 
specified program. 
Interrupts can thus be used to perform high-speed processing that is not restricted by the cycle time. 
 

Example: When an interrupt input signal is received, pulses are output.  

 

 

 

 

 

 

 

 

 

 

Input Interrupts for High-speed Processing 

How to perform specific control immediately after an 
input signal is received, without being affected by 
cyclic processing  

Input interrupts enable high-speed processing 
that is not restricted by the cycle time 

 

Pulse output  
OUT  

CIO 100.00 

Interrupt input signal 
IN2 (CIO 0.02) 

CP1E 

IN2 (0.02) 

When using the interrupt function.

Cyclic
task

I/O
reflesh

Interrupt
task

When not using the interrupt function.

I/O
reflesh

I/O
reflesh

Cyclic task

Cyclic
task

Cyclic task

Interrupt
occures Return

Output pulses

Input signal

Input signal

Output pulses

Quickly

Pulse output is started 
using the interrupt function.  
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1. Set IN2 (CIO 0.02) for an interrupt input in the PLC Setup. 
2. Create the ladder program in a cyclic task to enable input interrupt IN2 (CIO 0.02). 
3. Create the ladder program in the interrupt task to output pulses.  
 
 
1. PLC Setup 

Set IN2 to [Interrupt] in the [Interrupt Input] Field on the [Built-in Input] Tab Page.  

 

 



2. Create the ladder program in a cyclic task to enable input interrupt IN2 (CIO 0.02). 
 

The interrupt function is disabled when the PLC is first turned on.  

The MSKS instruction is used to enable and set interrupt inputs. 

 
 

 Specifying Up/Down Differentiation of 

an Interrupt Input 

Enabling/Disabling Interrupt Input 

Setting 

N: Interrupt 

identifier 

I/O Interrupt No. 

112: Interrupt input 2 (interrupt task 2) 

113: Interrupt input 3 (interrupt task 3) 

114: Interrupt input 4 (interrupt task 4) 

115: Interrupt input 5 (interrupt task 5) 

116: Interrupt input 6 (interrupt task 6) 

117: Interrupt input 7 (interrupt task 7) 

I/O Interrupt No. 

102: Interrupt input 2 (interrupt task 2) 

103: Interrupt input 3 (interrupt task 3) 

104: Interrupt input 4 (interrupt task 4) 

105: Interrupt input 5 (interrupt task 5) 

106: Interrupt input 6 (interrupt task 6) 

107: Interrupt input 7 (interrupt task 7) 

C: Control data #0000: Up-differentiation 

#0001: Down-differentiation 

#0000: Enable the interrupt 

#0001: Disable the interrupt 

 

Set IN2 (CIO 0.02) to [Up-differentiation] and enable the interrupt input. 
 

 

Specifying Up/Down 
Differentiation of an 
Interrupt Input 
Set [Interrupt input 2 
(IN2)] to 
[Up-differentiation]. 

Enabling/Disabling 
Interrupt Input 
Setting 
Set [Interrupt input 2 
(IN2)] to [Enable the 
interrupt]. 



3. Create the ladder program in the interrupt task to output pulses.  
(1) Add a new ladder program and assign the interrupt task in the [Program Properties] Dialog Box.  

Select [Interrupt Task 02 (Built-in Input 2)] to use IN2 for the interrupt input. 

  

 

 

 

 

 

 

 

 

(2) Set to output 600,000 pulses at the maximum frequency of 50 kHz. 

Set the parameters required for the PLS2 instruction in D0 to D7. 

Setting Address Data 

4-digit hexadecimal 

Acceleration rate: 300 Hz/4 ms D0 #012C 

Deceleration rate: 200 Hz/4 ms D1 #00C8 

Target frequency: 50,000 Hz D2 #C350 

 D3 #0000 

Number of output pulses:  D4 #27C0 

600,000 pulses D5 #0009 

Starting frequency: 100 Hz D6 #0064 

 D7 #0000 

 

 

* Refer to The monthly news, C&N Vol.10 “Easy Positioning Using Pulse Outputs” for pulse 
output settings. 

 

 



(1) Select [Add Graphics] in the [Draw] Menu to display the [New Graphics] Dialog Box. Make the following 
settings. 

 

 

 

 

 

 

 

 

 

 

 

 
(2) Select “state0” in the [State Preview] Window. (The background turns green.) Right-click in the black 

editing box under “State0” and select [Load Graphic]. The [Open] Dialog Box will appear. 

Use NS Components on NB 

How can I use the beautiful components of the 
CX-Designer on the NB? 

Set in Add Graphics and Load Graphic. 

 

• Name: SW1 (any name) 
• State No.: 2 (ON and OFF) 
• Type: Select the [Bitmap] Option 

Set Width and Height to the width and height 
displayed in the NB-Designer.  
(The above are the default values.) 

Right-click 
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ｚ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

(3) From the [Look in] Drop-down List, select a folder containing the required image under the [BMPfiles] 
folder in the installation folder of the CX-Designer. Select an image to use (OFF color), and then click the 
[Open] Button. 

   The selected image will be loaded into“state0”. 
   When the CX-one is installed normally, the default path of the [BMPfiles] folder is as follows: 
        C:¥Program Files¥OMRON¥CX-One¥CX-Designer¥intaparts¥BMPfiles 
 

 

 

 

 

 

 

 

 

 

 
(4) Select “state1” (green background). Right-click and select [Load Graphic] to load the ON image. 
 

 

 

 

 

 

 

 

 

 
(5) Select [Save] in the [File] menu to save the project after loading images into “state0” and “state1”. 
 



(6) The name of the created bitmap graphic, which is specified in step (1), appears in the [Project File 
Window]. Double-click the name to show the images loaded in step (3) and (4), as shown below. 

 

 

 

 

 

 

 

 

 
(7) Follow the below steps to use the newly created bitmap graphic as a graphic display for a component in 

the NB-Designer. 
  1) Place a component in the screen. 
 2) Double-click the component to open the property window. 
 3) Select the [Graphics] Tab, and then select the [Bitmap] Check Box 
 4) The created bitmap graphic appears. (OFF image loaded in step (3) is displayed.) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 
  5) Click the [OK] Button. The component using images loaded in step (3) and (4) appears on the screen. 
 

Double click 



After a workpiece is detected, the high-speed counter starts to count the feeding 
amount. When the present value of the high-speed counter reaches the target value, 
feeding is stopped. 
Target value comparison of the high-speed counter enables high-accuracy 
positioning by counting rotary encoder outputs. 
 

 

 

 

 

 

 

 

 

             

 

 

 

Start Flag (IN1.00)

Running moter signal (OUT100.00)

Work detection signal (IN0.02)

High-speed counter0 PV

Constant lengths Constant lengths

5000

0

 

Positioning Using High-speed Counter 

How to perform specified distance positioning 

High-speed counter is used to feed specified distance. 

 

CP1E 

Encoder output signal: High-speed counter0 

Workpiece detection 
interrupt input  
CIO 0.02 

Motor start input 
CIO 1.00 

Motor run output 
CIO 100.00 

Rotary Encoder 
E6[] 
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1. Set High Speed Counter 0 and Interrupt Input IN2 in the PLC Setup. 
2. Create the ladder program for target value comparison using the CTBL instruction. 
 
 
1. PLC Setup 

Set High Speed Counter 0 and Interrupt Input in the [Built-in Input] Tab Page. 

(1) High Speed Counter 0 

• Select the [Use high speed counter 0] Check Box. 

• Set Counting mode to [Linear mode]. 

• Set Reset to [Software reset] (to reset on the ladder diagram). 

• Set Input Setting to [Differential phase input]. (Set according to the encoder to use.) 

 

(2) Interrupt Input 

• Set IN2 to [Interrupt]. 

 

 



2. Create the ladder program for target value comparison using the CTBL instruction. 
Operation overview 
(1) When motor start input (CIO 1.00) turns ON, the motor starts. 
(2) When workpiece detection interrupt input (CIO 0.02) turns ON, the high-speed counter starts to perform 

target value comparison.  
(3) When the present value of the high-speed counter matches the target value, the motor is stopped and the 

present value of the high-speed counter is reset.  
 

Start Flag (IN1.00)

Running moter signal (OUT100.00)

Work detection signal (IN0.02)

High-speed counter0 PV

5000

0  

 

(1) Cyclic task 

 
(2) Interrupt task 2 is executed when a workpiece is detected (Interrupt input: CIO 0.02 turns ON). 

 
(3) Interrupt task 8 is executed when the present value of the high-speed counter reaches 5,000 (target value) 

 

 

(1) (2) (3) 

CIO 1.00 is turned ON to 
start motor. 

Setting of workpiece 
detection interrupt input  
(CIO 0.02) 
Specifying differentiation 
of interrupt input 
Interrupt Input 2 (IN2) is 
set to [Up-differentiation]. 

Enabling interrupt input. 
Interrupt Input 2 (IN2) is 
set to [Enable the input]. 

CTBL instruction for 
high-speed counters is 
used to make target value 
comparison setting. 

Motor is stopped.  

Present value of high-speed 
counter is reset.  



♦ CTBL Instruction 
The CTBL instruction is used to register a comparison table and perform comparisons for a high-speed counter 
present value. 

 

Set as follows. 

Parameter Set value 

High-speed counter number High-speed counter 0 

Control method Registers a target value comparison table and starts comparison. 

Number of target values 1 

Target value 5,000. The target value is valid when the PV is being incremented. 
Interrupt task number for 
target value 1 

8 

 

 P: Port specifier 

P High-speed counter number 

0000 hex High-speed counter 0 

0001 to 0005 hex High-speed counter 1 to 5 

 

 C: Control data  

C Control method 

0000 hex Registers a target value comparison table and starts comparison. 

0001 hex Registers a range comparison table and performs one comparison. 

0002 hex Registers a target value comparison table. 

0003 hex Registers a range comparison table. 

 

 TB: First comparison table word 

Setting Address Data 

Number of target values: 1 D100 &1 

Target value 1: 5,000 D101 to D102 &5000 

Interrupt task number for target value 1: 8 D103 &8 

  Interrupt task number 

 



 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. Select [Offline Test] in the [Tools] menu to start the offline test. 

    

2. Display the screen to copy. 

 

Paste Screenshots into Documents 

How do I easily copy NB screenshots and paste them 
into documents when I create machine specifications 
and manuals? 

Now you can copy offline test screens to the 
Clipboard and paste them. 
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3. Right-click on the screen and select [Screenshot].  

The screenshot is copied to the Clipboard. 

 
 

 

4. Open the document to paste the screenshot. Use a keyboard shortcut Ctrl + V or right-click then select 

[Paste] to paste the screenshot into the document. 

   



 

The high-speed counter counts pulses output from the Rotary Encoder. 
When the high-speed counter value is within the specified angle range, output turns ON. 
Using the high-speed counter, the ladder diagram to turn ON control outputs is created. 
 

 

 

 

 

 

 

 

 

             

 

 

0° 30° 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 360°

Ctrl output1

Ctrl output2

Ctrl output3

Encoder output
High speed counter PV

Ex：360 pulses/rotation (1 pulse=1°)
 

 

Cam Motion Using High-speed Counter 
 

How to implement angle control of rotating machines 

High-speed counter is used for angle control of 
rotating machines. 

 

CP1E 

Encoder output pulse 
(input to high-speed counter 0)  

Control output 1 to 3 

Increment Rotary Encoder 
E6B2-C 
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1. Set High Speed Counter 0 in the PLC Setup. 
2. Create the ladder program to compare the high-speed counter value and turn ON control outputs. 
 
 
1. PLC Setup 

Set High Speed Counter 0 in the [Built-in Input] Tab Page. 

• Select the [Use high speed counter 0] Check Box. 

• Set Counting mode to [Circular mode].  

• Set Circular Max. Count.  

Set according to the encoder resolution to use. 

As an Encoder with a resolution of 360 ppr is used in this example, set to [359] (360 ppr: 0 to 359). 

• Set Reset to [Software reset] (to reset on the ladder program without using phase Z). 

• Set Input Setting.  

Set according to the encoder to use.  

As the E6B2-C is used in this example, set to [Differential phase input]. 

   
 

The bits and words in the Auxiliary Area related to high-speed counter 0 are as follows. 

• High-speed Counter 0 PV 

A271 A270 

Upper 4 digits Lower 4 digits 

  

• High-speed Counter Reset Bit 0 
A531.00: When it turns ON, the present value of high-speed counter 0 is reset (set to 0). 

 



2. Create the ladder program to compare the high-speed counter value and turn ON control outputs. 
Operation overview 

The present value of high-speed counter 0 (A270 and A 271) is compared with the specified values using 
comparison instructions, and control outputs are turned ON. 
• When W0.00 turns ON, the comparison starts. 

• When W10.00 turns ON, the present value of the high-speed counter is reset (set to 0). 

0° 30° 60° 90° 120° 150° 180° 210° 240° 270° 300° 330° 360°

Ctrl output1(OUT100.00)

Ctrl output2(OUT100.01)

Ctrl output3(OUT100.03)

Encoder output
High speed counter PV
(A270～A271CH)

Ex：360 pulses/rotation (1 pulse=1°)
 

  

 

 

When W10.00 turns ON, 
high-speed counter 0 PV is reset. 

Control output 1 (CIO 100.00) is 
turned ON when the angle is 
between 30° and 59° or  
between 210° and 239°. 

Control output 2 (CIO 100.01) is 
turned ON when the angle is 
between 120° and 179° or  
between 300° and 359°. 

Control output 3 (CIO 100.02) is 
turned ON when the angle is 
between 60° and 89°, 
between 120° and 149°,  
between 240° and 269°, or 
between 300° and 329°. 

 
 



Helps Reduce Design Time in NB-Designer 

When I select and move a component, 
only its label is selected and moved. 

In Ver. 1.34, the component and label can be 
moved together even if you click on the label. 

 Note. The NB-Designer version 1.34 is released in August 2014. 

 

♦ NB-Designer version 1.33 or lower 
When a component is clicked near its label to move the component, only the label is selected and 
moved by dragging it, and the component remains in the original position. 

 
 

 

 

 

 

 

 
 

♦ NB-Designer version 1.34 or higher 

The way to select a label is improved. 
Even when a component is clicked near its label, the component and label can be selected and moved 
together by dragging them.  

 

 

 

 

 

∗ When you want to move only a label 
When the component and label are selected, click on the label again to select only the label (the label 
will be surrounded by a white frame) and drag it to the desired position. 

Only label 
moves. 

Label is selected. 

Drag 

Component and label 
are selected. 

Component and label 
are moved. 
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1. Download Cool objects for NB from the OMRON JAPAN website: 

  http://www.fa.omron.co.jp/products/family/3110/download/software.html 

  

 

 

 

 

 

 

 

2. After downloading nb-parts_e.zip and B150127.pdf, extract the contents from nb-parts_e.zip. 

3. Double-click nb-parts_e.nbp in the nb-parts_e folder to start the NB-Designer. 

4. Select Language2 under View - Language to display labels in English. 

5. The screen 20 and the following screens contain "cool" templates. See page 12 and the following 

pages of B150127.pdf for details on templates. 

 

 

 

 

 

 

 

 

Create Beautiful Screen with NB-Designer 

 

Professionally designed "cool" templates 
are available. 
Just download "cool" templates and objects from the OMRON website and customize 
them as you like to create good looking screens! 

The touch panel serves as the face of our machine. 
How to create good looking screens easily? 

Click!
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6. Three different types of screen templates are provided. 

 

 

 

 

 

 

7. How to use a Metal template is explained below. Create a new project and add the NB7W that uses the 

template. 

1) Copy the screen 32 (background) of nb-parts_e.nbp (right-click on the screen and select [Copy]), 

and then paste it on the screen 0 of the NB7W in the new project (right-click and select [Paste]). 

2) In the NB7W, select [Add Screen] in the [Screen] menu to add a screen. (The screen 10 is added.) 

3) Open the screen 20 of nb-parts_e.nbp. Copy the objects (right-click, select [Select All]. right-click 

again, and select [Copy]), and then paste them on the screen 10 of the NB7W.  

4) In the screen 10 of the NB7W, select [Screen Property] in the [Screen] menu to open the [Screen 

property] Dialog Box. Set Sheet Screen 1 to [0:Frame0] (screen 0), and click the [OK] Button. 

 

 

 

 

 

 

 

 

5) The Metal template is pasted on the screen 10 of the NB7W as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Metal Natural Pop 

When two or more screens are added, 

set Sheet Screen 1 to [0:Frame0] in the 

[Screen property] Dialog box of each 

screen. 



 
  

8. The following templates are also included in Metal as well as Natural and Pop. 

 

   

 

 

 

9. The nb-parts_e.nbp also includes the following "cool" objects. 

  Refer to B150127.pdf for details on how to use objects. 

 

 

 

 

 

 

 

 

Screen 24 Screen 29 Screen 27



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
*  CP1W Analog Option Boards can be mounted to the CP1E-N30/40/60D□-□ CPU 

Units version 1.2 or later.  
They cannot be mounted to the following models:  
CP1E-E□□D□-□/E□□SDR-A/N14/20D□-□/N□□SD□-□/N□□S1D□-□ 

Use Analog Option Boards 

Now an Analog Option Board can be used for the CP1E. 
How do I install it? 

CP1W Analog Option Board can be added to CP1E. 

 

CP1E* 

CP1W-MAB221 CP1W-ADB21 CP1W-DAB21V

CP1W Analog Option Boards 
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Models and Specifications 

Product name Model Specifications 

Analog Input Option 

Board 

CP1W-ADB21 2 analog inputs 

0-10 V: Resolution 4,000, 0-20 mA: Resolution 2,000 

Analog Output 

Option Board 

CP1W-DAB21V 2 analog outputs 

0-10 V: Resolution 4,000 

Analog I/O Option 

Board 

CP1W-MAB221 2 analog inputs 

0-10 V: Resolution 4,000, 0-20 mA: Resolution 2,000 

2 analog outputs 

0-10 V: Resolution 4000 

 

Setting 

1. PLC Setup 

Set in the [Serial Option Port] Tab Page. 

(1) Communications Settings: Select the [Custom] Option. 

Set Baud to [115200]. 

Set Format to [7,2,E]. 

Set Mode to [Host Link (Default)] or [Host Link]. 

(2) Unit Number  : Set to [0]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Enabling PLC Setup 

Turn OFF the power, and then turn ON again to enable the PLC Setup. 



Memory allocation  

 Analog input values and analog output set values are allocated to the following words of the CP1E: 

Word CP1W-ADB21 CP1W-DAB21V CP1W-MAB221 

CIO 80 Analog input 1 --- Analog input 1 

CIO 81 Analog input 2 --- Analog input 2 

CIO 85 --- Analog output 1 Analog output 1 

CIO 86 --- Analog output 2 Analog output 2 

 

Refer to the CP1E CPU Unit Software User’s Manual (Cat. No. W480) for details. 

 

 

New CP1W Analog I/O Units and Temperature Sensor Units have been added to the line up. 

 CP1W Expansion Units 

Product name Model Specifications 

Analog Input Unit CP1W-AD042 4 analog inputs 

Resolution: 12,000 

Analog Output Unit CP1W-DA042 4 analog outputs 

Resolution: 12,000 

Analog I/O Unit CP1W-MAD42 4 analog inputs, 2 analog outputs 

Resolution: 12,000 

CP1W-MAD44 4 analog inputs, 4 analog outputs 

Resolution: 12,000 

Temperature Sensor 

Unit 

CP1W-TS003 4 thermocouple inputs 

2 analog inputs* 

* Two channels can be used for thermocouple or 
analog input. 

CP1W-TS004 12 thermocouple inputs 
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